


S7_Komm_S7300_cn.doc

Copyright © Siemens AG 2008 All rights reserved

Sl E M EN S S7 communication between S7-200 and S7-300/400

4<H ID: 17369594

Hx
S5 SRR 2
L R 2
WL TR, fnff#e S7-200 5 S7-300/400 2 [AIZHZAS ST BN T
L = TR 2
B ettt et eeueeeeaeeaeeateeteeaeaaeeateateateaseeeeteateateaseeseesseateaseaseeseeaseasiaseaseeseenneaseaseateeseenneneeneann 2
T H SRR — AT T B DR oo, 2
1 BT oot e et et e et e et e et e et e ateateeeeeeeateateateanaeneeneanaaneaneeneeseaseaneannaneenneneannannnnen 3
2 ZE S7-200 F1 S7-300/400 Z [E]HEIT ST T eeeerreerieeiirieriiensseessessesssesssesnesseens 4
2.1 ZE ST7-200 T A R BT oo 4
AN ST-300 [ P U T TS oot 8
LHZAR—F ST-400 [T P BHIEEE oot 11
2.2 207 S7-300/400 4RSS B8 MRAEAT ST BT 18
2.3 ZE S7-200 A RS BB B e, 20
ZHA—E] ST-300 RS AT oo 23
ZAA—E] ST-400 IR B-IERE oo, 234
2.4 S7-300/400 AR REIT ST BT cvveeeeeeeeee e 28
L A ST T oo, 28
ZE ST T H U B TS B oo 31
3 TN 2 1 < 32
IR TG F B S W E AR TR M R4, v AR & — e
1T FE
http://support.automation.siemens.com/\WW/view/en/17369594
I 725
it TP LUK, anfaffE S7-200 5- S7-300/400 2 [A| 47 ST7 1T E IR
BE?
R

T HISCRE R SR A — A0 2% R0 R A R 4 A

V1.1 15.08.2008 2/32


http://support.automation.siemens.com/WW/view/en/17369594

Copyright © Siemens AG 2008 All rights reserved

S7_Komm_S7300_cn.doc

SIEMENS

S7 communication between S7-200 and S7-300/400

4 H ID: 17369594
ik
S7-200 WLt CP243-1 1E MRS Aeim A% v sr ST &EH:, XEWE
LA AT RE
o {E S7T-200 "ECE —ANE ), K ST-200 ¥ 32 sl S R R 45 s 1)
ST E#:.
o 7E ST-200 P lc B AR SS we i, TR ST-200 W] 4k 2 (1K) i N g 37 4 fr) ST 3%
P2, R 2% P ks 5 ST-200 EEA7 RS, ST-200 1E 4 IR 45 et At % s .
YE STEP 7 Micro/WIN HEHLUKM M54 S7-200 4% S7 #HIMACE, *
T S7-300 A S7T-400 {E STEP 7 Wh5gRk S7 BN S

A, S7-200, S7-300 F1 S7-400 £ H 4> CPU Fl—ANE AN, 1%
Fr b AT ok FHAE R LUK A TREE 1) S7-300 1 S7-400 [¥) CPU.

V1.1

15.08.2008 3/32



Copyright © Siemens AG 2008 All rights reserved

S7_Komm_S7300_cn.doc

SIEMENS

S7 communication between S7-200 and S7-300/400

2 1£S7-200 F1S7-300/400 2 |8]3#4TS7 @ H

2.1 1ES7-200 FARE P UER

4 H ID: 17369594

Afgirh, S7-200 475 K% 7 sk AT S7 3 IR, 1T, S7-200 ¥ L 5h i 5 S7-
300 =% S7-400 ) S7 i%E$%. S7-300 m S7-400 54l 50 i 1 i V7 U 1) S7 1% 4%

WP SR & R

e PLC 315-2DP (6ES7 315-2AG10-0AB0) A1 CP343-1 (6GK7 343-

1EX30-0XEOQ)

e PLC 416-2DP (6ES7 416-2XK02-0AB0) F1 CP443-1 (6GK7 443-

1GX11-0XEOQ)

e PLC 222 (6ES7212-1AB22-0XB0)#1 CP243-1 (6GK7 243-1EX00-0XEQ)

K 2-1 PR AR E S W

server
S$7-300 with CP343-1
— ip address: 140.80.0.50
TSAP: 03.02

]

JIL]

SCALANCE X108

client
S§7-200 with CP243-1

—

E

o] |

server
$7-400 with C443-1

= ip address: 140.80.0.150
TSAP: 03.03

ip address: 140.80.0.60
local TSAP for S7 connection 1: 10.00
local TSAP for S7 connection 2: 11.00

LEAAG H, S7-200, S7-300 1 S7-400 (1) KA XI5 XA ik FHI 22 v X

V1.1 15.08.2008

4/32



Copyright © Siemens AG 2008 All rights reserved
S7_Komm_S7300_cn.doc

Sl E M EN S S7 communication between S7-200 and S7-300/400

4 H ID: 17369594

2-2 S7-200, S7-300 11 S7-400 1 4% Mgzl & X
client server

S7-200 S7-300

ite dat
VBO0-VB7 piede :I DB20 ByteO — DB20 Byte7 |
VB10-VB17 |20 } DB20 Byte10 — DB20 Byte17 |
VB20-VB27 S7-400

! DB30 Byte0 - DB30 Byte? |

_| DB30 Byte10 — DB30 Byte17 |

1L AE START Menu > SIMATIC "I sl Xk S i L 19 AR 7] 44 7 (R - BT T
STEP 7-MicroWIN.

Wit Tools > Ethernet Wizard...“T JF LI 1] 5.
2-3 FTIFLLR M )

7= |STEP 7-Micro/WIN - TEST - [SIMATIC LAD]
7)) File Edt View PLC Debug | Tooks Windows Help

o, Instruction Wizard...
LAV | | el . 57-200 Explorer....
Clicas % = o
= TEST(C
@ wh  Position Control Wizard, ..
- B cPL  EM 253 Control Panel...
= =1-[gH Fro;  Modem Expansion Wizard. ..
Program Block i3 Ethernet Wizard. ..
D N
= &
4 ] .

Symbol Table (@l Sym  pataLog Wizard...
@ Sta  pip Tune Control Panel...
T Dat:
= w-0E) Syst  Customize
Status Chart by Cros  Options

LN .
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2-4 LUK ) T4

Ethernet Wizard - - _)g

This wizard will help you configure the CP 243-1 Ethernet module in order bo connect an 57-200 PLC
to an Ethemet network. Ethemmet iz based on the IEEE 802 3 standard, with communications
protocols based on IS0 and TCP/IP. The CP 243-1 module offers data transmission up to 100 Mbit/s
over the network, and suppoits up to 8 concument connections.

Industiial Ethemet iz designed for industry. ]tcmbeuwdwitheifmnoiwﬁea industrial twisted pai
(ITP) technology, or the Industiy-standard twisted pair (TP) technology. Industrial Ethernet can be
implemented to offer a wide tange of application-specific uses such as switching, high-speed me&.ln
redundancy, fasicarmds ardtedu'dantnelmks Lising the CP 243-1 module. the 57-200 PLC

- .J:.-

e TR b pioduicts that suppon Ethemet, TSk Mewt' to oo Ly
umlmsmlemlﬁwumlollyuwulaiwt:umlml e 1o Coim waﬂu

2431 module for your program.

il

s
]
£
c
&

r
]
]
Industrial @

Press F1 for help on any Wizard screen.

<Frev Cancel l

R SIMATIC Field PG iiid Tk UK MIZEH: T CP243-1, Jiid i di“Read
Modules™ %41 7] 55 H 8 V50 BIREER iR A7 B 24 4Rt 0T LTSl i AR R A7
2 )5 il Next s 4H.

Kl 2-5 P #

Ix

This wizard will help you define the parameters for the CF 2431 Ethernet module, The wizard will then
place this configuration in your project.

~ Specify Module Pasition

To configure the module, specify the module’s position relative to the PLC. Click 'Read Modules'
| to search for installed CP 243-1 Ethemet modules.

Module Position
Pasition | Medule ID
4 [

Prev || New [] Concel |
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3 CP243-1 3 fit— > HA ) 1P Hiuhik K AR A1 W4 # 65 a ifv, Next” $228W

BH.

2-6 f3 CP243-1 43Hc IP ik
Ethernet Wizard (ETH Configuration for 0)

Ise

-Mo:l.le i m=sa
Please select the address to assign to this CP 2431 module. If your network provides a BOOTP
server [a service that will automatically assian 1P addresses at startup), you may choose to have an
IP address automatically assigned.

IP Address: |1au.au. 0 .60 |
Subnet Mask: |255.255. 0.0

Gateway Address: 0D.0.0.0

[~ Allow the BOOTP server to automnatically assign an IP address for the module,

~ Madule Connection Type
Specily the communications connection type far this module.

-
1]
£
E
1]

=
=

i

| |

Industrial

l Auto Detect Communications _ﬂ

<Prev Next> Cancel |

TR IR AE G 4 A CP243-1 #E4T ST iE RIS RAR I BCE W S7 &R
A UL AR AR PR AT 12 5 Bt . il Next™ 2 4k sE 1T ST AR A1
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2-7 WH ST HEYE

— Module Command Byte

Determine the O-addiess by counting the output butes used by any 1/0 modules attached to the
PLC befate the CP 243-1 module.

e[ =

— Peerto-Peer Connections
The CP 243-1 module will support & masimum of B asynchionous, concurrent connections. Select
how many conneclions you wish to configure for this modude,

"
]
£
g

.

=

L

]

Industrial

Chick "Mext' bo edit the connectiors for this configuration.

<Prey Next> Cancel

HA—/NF) S7-300 (K% ik s
A ST RS A %) S %

X Tz FE 2 5 N IR 45 2 i A IP bk P CP343-1 111S7-300 uh4F g Il 45 2
T %, CP343-1 1Pl 4 140.80.0.50 (3 WK 2-1 fifif: 20 A8 e &

M LA
BBE).

S7-200 Fi1 S7-300 [t S7 &8s ik TSAP k52 Y. S7-200 1l 1% ;= i %45 4
FUN A I FE TSAP BEE A 03.02. 1% TSAP & X F:

o 03: RINHKRERE
e 02:S7-300 34 PLC S (K4 2)
2 )5 fii, Data Transfer“%4l.
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2-8 HAF) S7-300 [F)%% - o i 2
>

ou hawve requested 4 connection(z]. For each connechion, specify whether the connection should act a5 a
client or server, and configuie its associated properties.

— Connection 0 [4 connections requested|

% This is a Client Connection: Client connections request data transfers between the local PLC and a
remote server,

€ Thisis a Server Connection: 5ervers respond to connection requests from remote clients.

r Local Properties (Client)———————————§ ~ Remote Properties [Server] ]
TSAP TSAP

| 10.00 I 03.02

You may defing up to 32 data ransfers between | | Specify the IP address of the server for this
thiz connection and the remote server. connection,

Data Transfers... 140, 80 . 0 . 80

¥ Enable the Keep &live function for this connection.

Please specify a symbolic name for this clent connection. 'Your program can reference this connection
symbolically when initisting data transfers with the remote server.

|Cnnncdionl3_,ﬂ

¢Prey Conecion | Next Connections |

0K | Cancel |

A LLESE T A DfexT S7-300 5
s B b
o HHE PR R 55 4 IERL

By N5 NS P2 I 55 i TR A5 A s et R K/ X Ll 8 7 1 IR £kdl (VBO-VB7 ) 5 N
S7-300 H1.'5 NIk R 7 /E S7-300 (1) DB20 H(“7- 715 0-7).

i, Next Transfert& Al HE4T M S7-300 Sz EU s 1 .
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2-9 5 Nk 2 S7-300 H
Configure CPU-to-CPU Data Transfers

CPU data transfers can be used to lransfer blocks of data between the local PLC and &
remote server when the local PLC is equipped with a CP 243-1 module. Data transfers may
be defined to read data from the server. or wite data from the local PLC to the server. Click

‘Wew Transfer' to configure additional data ransfer operations.

- Data transfer 0(2 defined)-

This data transfer should:
" Read data from the remote server connection.
' wiite data to the remote server connection.

Howe many bytes of data should be waitten to the server?

‘where is the data in the local PLC? ‘Whete should the data be stored in the server?

A zymbaolic name will be defined for this data transfer in your project.
|PeerMessageDD_1

| WED tel VE7 | DB20.DBBD o | DE20.DBBY

X

Delete Transfer I < Previous Transfer ]I Mest Transfer >

oKk |

Cancel |

FTLLIERE R A TIHEM S7-300 i H K df:
s B b
o MIZFEMR ST FIERE b B

4 H ID: 17369594

i N\ WS FE AR 55 4 HH s B AR s 1 1 /NI L 8 T B i A S7-300 (1)
DB20( 15 10-17) B, seH 2 dis # 176 7E S7-200 1) VB10-17 .

s i, OK™ HZAH N I B AR5 B
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& 2-10 M S7-300 Eimﬂxéﬂz%

CPU data ransfers can be uzed to transfer blocks of data between the local PLC and a
remote server when the local PLC iz equipped wath a CP 2431 ﬁwo‘qEJIE _DE_I':‘EI transfers may

be defined to read data from the server, or wite data from the iocal PLC to the server. Cick
‘New Transfer' to configure additional data trarsfer operations.

ala o1 (2 defined)

This data transfer should:
' Read data from the remote server connection.
" Wiite data to the remote server connection.

How many bytes of data should be read from the: server?

| =]
-

Local PLC Server (140.80.0.50)

‘where should the data be stored in ‘where should the data be read from in the:

the local PLC? seIver?
| wmto| VB17 J DB20DBB10  to | DB20.DBEB17

A, spmbolic name will be defined for this data transfer in your project.
|Pee:Message01'l_2

Delete Transfer | < Previous Transter | New Transter |

. P

HAE—/NF ST-400 (& P i iEs:
A ST ERERIFELLA N % 7 i i 4.

XTI FESHU I AR S5 & (K IPHB L. 7i7CP443-1 [11S7-400 fiff: A i 55 4
TR AR iRz, CP443-1 (11PN 140.80.0.150 (2 ILIE| 2-1 RE {4
A C E S ).

S7-200 F1 S7-400 [#) S7 &t TSAP K5 X. S7-200 (1155 ;i & 4% 4y
NS CFE TSAP B E 4 03.03. 1% TSAP & Xk

e 03: S7-400 35 PLC g5

ER AL S7-400 st (TS 4k PLC KM

2 )5 fiiti, Data Transfer“d%4.
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2-11 4173 S7-400 (15 7 i ik 12

x|
You have requested 4 hon(s). For each ion, specify whether the connection should act as a

client or server, and configure its associated properties.

 Connection 1 [4 N d)

@ This is a Client Connection: Client connections request data transfers between the local PLC and a
remote server.

" Thiz iz a Server Connection: Servers respond to connection requests from remote chients.

- Local Properties [(Chert) | ¥ Remote Properties (Server))
TSAP TSAP

| 11.00 03.03

You may define up to 32 data transfers between Specily the [P address of the server for this
thiz connection and the remote server, connection.

Data Transters... 140,80 . 0 150

¥ Enable the Keep Alive function for this connection.

Please specify a symbolic name for this client ce tion. ‘Your program can ref this connection
symbolically when intiating data transfers with the remote server.
|Eonnectionﬂ_1
< Prev Connection | Mext Connection > |
ok | Cencel |

FTLLESE R A ThfExT S7-400 5 % d:
plenra iy
o HHE PR AR 55 A IE L

B N5 NI RE IR 45w IO B0 2 1 K/ X B 8 1 i (VBO-VBT7 ) 5 N
S7-400 H."5 NIk (R A7 4E S7-400 (1) DB30 H (475 0-7).

fiiti,Next Transfer* 3% 4 3547 M S7-400 S HUE s e &

V1.1
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Kl 2-12 5 AN H#E 3 S7-400
Configure CPU-to-CPU Data Transfers

X

CPU data transfers can be used to transfer blocks of data between the local PLC and a
remote server when the local PLC is equipped with a CP 243-1 module. D ata transters may
be defined to read data from the server, of wiite data from the local PLC to the server. Click
‘Mew Transfer' to configure additional data transfer operations.

r— Data transfer 0 [2 defined)

Thiz data transfer should:
" Read data from the remote server connection.
" Wiite data to the remote server connection.

How many bytes of data should be wiitten to the server?
[ e
Local FLC Server (140.80.0.150)

= O

‘Where is the data in the local PLC? ‘Where should the data be stored in the server?

| VB0 u:| VB7 | DE30.DBBO  to | DE30.DBE7

A symbolic name will be defined for this data transfer in vour project.

IF’eerMessageD‘l_‘J

Delete Transfer ¢ Previous Transfer II Mext Transfer > I

ok | Cancal |

FTLLIERE R A DIHEM S7-400 i HU 4
s & b

o MITRER 55 FER U

TN M R 25 8 S 5 s 1R /NI FEL O 8 S Bk A S7-400 11
DB30(+ 11 10-17) P 2. s ik A7 it 7 S7-200 1¥) VB20-27 .

s i, OK™ HZAH N I B i AR5 B
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2-13 )\ S7-400 iz B
|

CPU data ransfers can be used to transfer blocks of data between the local FLC and a
temate server when the local PLC is equipped with a CP 2431 module. Data transfers may
be defined to read data from the server, or wite data from the local PLC to the server. Click
‘New Transfer to configure additional data transfer operations.

— Data transfer 1 (2 defined)

Thiz data transfer should:
% Read data from the remote server connection.
" \Wiite data to the remote server connection.

How many bytes of data should be read from the server?
93.

Local PLC Server (140.80.0.150)

Where should the data be stored in ‘Where should the data be read from in the

the local PLC? sefver?
‘ YB20 ml VB27 | DB30.DBB1D  to I DB30DBE17

A gymbolic name will be defined fior this data ransfer in your project.
}Pee!MessageEﬂ_Z

Delete Transfer < Previous Transfer | New Transfer |

) oo

tHF CP243-1 Bl i) 2 & AT BEAS VR F U o5, IR e At 8Lk CRC R4 138
Alive Interval i [a] fR¥EFGRAE B . 2 )5 i, Next s 4.

V1.1
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2-14 CRC #4741 Alive Intervall I} a] % &

i Il
 CRC Protection
The wizard can generate a CRC to help protect the module configuration from unintertional
memory ovenwiites. Howeves, this protection will also prevent your program from making
moadifications ta the configuration at run time.
(¥ Yes, generate CRC protection for this configuration in the data block.
" Mo, do not generate CRC protection for this configuration.
o Keepmt'rﬁeﬁfd e . At s e R — sass -
» Wwhen conrected with a remote communications partner, or when communicating with STEP
[ T-Micto MWIN. the CP 2431 module can ensure the connection on a timed interval. Specify the
3 interval for the Keep Alive function, in seconds.
Im:luzl.nm;
EE -
<Prev New> |  Cancel
A B H X T A AR
2-15 f7 i CP243-1 AL UEE
Ethernet Wizard (ETH Configuration for 0) T e X

~ Allocate Memory for Configuration =

The configuration block for this module requires 24 bytes of V-Memory. With the oplions you
have chosen, the total size of the configuration is 245 bytes. Please specily a stating addiess
where the configuration will be placed in the Data Block.

The wizard can suggest an address thal represents an unused block of V-memory of the comect
ze,

Suggest Address |
| VB212 thiough VBA45E

<Prey Mewty Cancel

s, Finish* 8 58 B LUK R 1) 5 BEE.

V1.1
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2-16 52 CP243-1 LUK M A& E

Ethernet Wizard (ETH Configuration for 0) "I

S7_Komm_S7300_cn.doc

the following project components:

" 2 ﬁ = The Ethemet Wizard will now generate the project components fior your selected configuration
P = and make that code available for use by your program. Your requested configuration consists of

The module configuration will be placed at [WVBO - VB201) n Data Page "ETHOD_DATA™
Subroutine "ETHO_CTRL"
Subroutine "ETHO_=<FR"

(Global Symbol Table "ETHO_SYM"
| I

Call the intialization and control subroutine "ETHO_CTRL" every scan.
The CP 243-1 moduls configuration must be downloaded to the PLC before use.

name to better identify this wizard configuration.

E TH Coanfiguration for 0

This wizard configuration will be referenced in the project tree by name. You can edit the default

ov ([ ) ool |

Z JG Wik ETHx_CTRL Al ETHx_XFR 54 1 2t 4 45i¢F STEP 7-MicrowWIN

f) EAEERH(“MAIN (OB1)”)H i Fix b Th g e
Ihfed ETHx _CTRL F T4k 37 .
2-17 i/l ETHO_CTRL

Copyright © Siemens AG 2008 All rights reserved

| PROGRAM COMMENTS
Network 1 Metwork Tithe
[ Metwark Comment
SMO.0 ETHO _CTRL
| L
1 I EM
CP_Re~ 1000
Ch_Re™ | Mwi12
Errorf- Mw14

it ETHx_XFR H T35 ## . ETHX_XFR i 55— A% ) s e B F

o3I S7-300 Hisk BCA & 5 A\ Hdls 1) S7-300 H.

V1.1
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2-18 il ETHO_XFR H-F5 S7-300 31T 5 28 #ie

Network 2
[
SHM0.0 ETHO_XFR
| |
SM05
1 1
i | START
Connection]_04Chan_ID  Donev50,1
PeeiMessagell 14 Data Error - VBS2
VGO0 Abort
Symbol | address Comment
| Connection0_0 | VB424
PeeiMessage00_1 YB425
MNetwork 3
|
SM00 ETHO_*FR
| |
i I EM
|SMIJ.!SI
1 [ START
Connectiond_04Charn_ID  Donep V54,1
PeerMessagell_24Data ErmorVBEE
Va4 0 Abart
[ Symbol I Address Comment
Connection(_0 VB424
| PeeiMessage00_2 YB426

4 H ID: 17369594

[FJFE L ETHX _XFR G 55 A% S 3 B0 F W9 ¢ 23 7 FH 3 A\ S7-400 i3
WO f 5 N Hdla 21 S7-400 .

V1.1
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K 2-19 i ETHO _XFR HF 5 S7-400 HE4T B2 #e

Network 4
|
SMO.0 ETHO_XFR
1
| o
SMO5
— | START
Connection)_14Chan_ I Donef'vE0,1
PeerMeszagell_1-Data EmorpYBEZ
WEO. 0o Abort
Symbol Addiess | Comment
| Connection(_1 VEB427
Peeibeszagell_1 VB428
Network 5
|
SMO.0 ETHO_XFR
| o
SMO5
—| i START
Connection0_14Chan_ID'  Done'E4.1
PeerMeszagell_2-4Data Emorp-YBEE
W64, (1< Abort
Spmbuol Addiess I Comment
| Connection(_1 VB427
Peeitdeszacell 2 VB429

FEDNREH ETHX_XFR "4 ik B dim A 24, Chan_ID“Fl,Data“. 2 & il LAMFF

TR N E RS

RAFAZSIF F#EI S7-200 H.

PEfR—A S7 ¥Herh, Dk ETHO_XFR AN % A I 4% 22 UG, 1T %
e MNME AR . AP RERTh SRE-AERUE, XFEESE A
ETHO_XFR $#4T%ith DONE {55 )5, 5~/ ETHO_XFR A #%ifH .

ZH&ST-300/400 AR 23 umEATST @R

S7-300 F1 S7-400 15 K R4 2a i 57, S7 G BT T8 L — AN R K %k
P54 (DB). S7-200 ¥ XA~ DB i He b 47 2 325, i% DB £ 5 43731
A Jg 3 RN R 22 i X

V1.1 15.08.2008 18/32
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7£ S7-300 ' DB20 1 Ky A i Fle i 22 v X
7£ S7-400 1 DB30 1k A i A 2 R X .

JoifE S7-300 1 S7-400 [#) NetPro Hr2H & S7 i%#z.

I AMB T T AE S7-300 F1 S7-400 [FE > A i FHATART )8 THID e B

Bt ST A BHE A #

£ STEP 7-MicroWIN $TFF S7-200 (#1551 H F2) 7 - Ul BPR A I f %. 2 5 n)
DAL SRR 221 X (VB10-17 F1 VB20-17) & 15 25 34T B A8 #e. 5 At 7] LA
R IR X (VBO-T) 1 5

7£ S7-300 F11 S7-400 (1] STEP7 H 43 Jilfdi A — A48 & 3%l ik A & 38 ] DL 8%

S7-300 A1 S7-400 #2225 v X 11 Bt A2 A6 Ho n] LR % S7-300 Fi1 S7-400
RIL R IX I E
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2.3 7EST-200 SRS 2R T
A, S7-200 4125 K IR 45 28 i B4 T S7 3K, %1 11,S7-300 it S7-400 ¥ 150
@y S7-200 (1) S7 3E4%. S7-200 K4k s b 1 v 416 S7 4R
AR AT B R
e PLC 315-2DP (6ES7 315-2AG10-0AB0) 7! CP343-1 (6GK7 343-
1EX30-0XEO0)
e PLC 416-2DP (6ES7 416-2XK02-0AB0) 1 CP443-1 (6GK7 443-
1EX11-0XEO0)
e PLC 222 (6ES7212-1AB22-0XB0) #! CP243-1 (6GK7 243-1EX00-
0XEO0)
K] 2-20 fifF 2 A S
$7-300 3::: tCP343-1 server
= IP address: 140.80.0.50 §7-200 with CP243-1
D TSAP: 10.04 IP address: 140.80.0.60 _
B i H [H—— looal TSAP for S conmection £: £2.00
D L]
SCALANCE X108
% | Industrial Ethernet
client
§7-400 with CP443-1 =0
— P add.ress: 140.80.0.150 [H_AL'
fEAMH, S7-200, S7-300 Fil S7-400 [ T 41 X 4w XAy Ak RN 22 ph X
& 2-21 S7-200, S7-300 Fil S7-400 3L L2 X
client server
[ s7-300 |
| DB20 Byte20 — DB20 Byte27 }: foad daro VBO0-VB7
| DB20 Byte30 — DB20 Byte37 Im
(5400 | [oeover ]
| DB30 Byte20 - DB30 Byte27 |«
| DB30 Byte30 — DB30 Byte37 I—
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1L AE START Menu > SIMATIC "I sl Xk S i L -9 AR 7] 44 7 (R TR 4T T

STEP 7-MicroWIN.

i, Tools > Ethernet Wizard...“¥T T LUK M 7] 3 (S ILIE| 2-3 T TF LUK M 117

9).
CAVPNCITCNE o

2-22 LUK [a) F4ifiik

Ethernet Wizard

S7_Komm_S7300_cn.doc

This vazard will help you configure the CP 243-1 Ethemet module in order to connect an 57-200 PLC
to an Ethemet retwoik. Ethemet iz based on the IEEE 8023 standard, with communications
protocols based on IS0 and TCPAP. The CP 243-1 module offers data ransmizsion up to 100 Mbit!s
avier the netwark, and supports up to 8 concunent connections.

Irﬂ.Ls:hla{Eﬂmialwdewﬂ:llmndmhy It can be used with either noise-free industial wisted pas
(ITP) technology, or the Industry-standard twasted pan (TP) technology. Industrial Ethemet can be
Wtadfua%:«mdwﬂcﬂmwﬁmmuwﬁum high-speed medium
redundancy, fast connects, and redundant networks. Using the CP 243-1 module, the 57-200 PLC i
compatible with a wide range of esisting products that suppert Ethemet. Click ‘MNest' to configure a CP
243-1 module for your program.

Prezs F1 for help on any Wizand scieen

Ix

Copyright © Siemens AG 2008 All rights reserved

R SIMATIC PG i Tk DIUKMIZER: T CP243-1, Jiid fidi“Read

Modules™ % 1 ] 5Kt B 3l 5 SIRLER A7 F. 24 28t n] DL Sl AL A7 5.

ZJi iaki,Next 4% 41.
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2-23 YU LR

4 H ID: 17369594

Ethernet Wizard x|
Thiz wizard will help you defire the parameters for the CP 243-1 Ethemnet module. The wizard will then
place this configuration in your projact.
~ Specify Module Position

To configure the module, specdy the module’s position refative to the PLC. Chick ‘Read Modules®
to search for mstalled CP 2431 Ethemet modules.
M odule Pozition
03: Read Modules |
Posttion | Module 1D
1] |
<Prev Next> Cancel |

 CP243-1 3l — AN A1) 1P ik A AHRY (1) P HERS. i, Next” T4 v

WH.

2-24 3 CP243-1 43 lic IP Mk

Ethernet Wizard (ETH Configuration for D) x

~ hiodule Address

|P address automatically assianed,

Please select the address to assign to this CP 243-1 module. If pour netwaork provides s BOOTP
server [a service Ih_ai will automatically assign IP addiesses at startup), you may choose to have an

IPAddress: | 140, 80 . 0 . 60

SubnetMask: | 256 255. 0 . 0

@

GumyAddress:|n_lJ.D.D

[ Allow the BOOTP server to automatically assion an IP address for the module,

— Module Connection Type

|r.dusma|‘§ Specily the communications connection type for this module.
] Auto Detect Communications E]
<Prev Mext> Cancel
V1.1 15.08.2008 22/32
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NI R T HERS BT 42 CP243-1 #E4T S7 3EREMERAR B A . d il 87
iﬁ%Tu LA E AT S Bl A, i Next 1 I 4k 2Lt T S7 #4641

n:» .

2-25 ¥ H ST EIEHE

Ethernet Wizard (ETH Configurationforn) x|

[~ Module Command Byte -

Determine the (-address by counting the output bytes used by any |/0 modules attached to the
PLC before the CP 243-1 module.

0B ]1 _,::I

i~ Peerto-Peer Connections

The CP 243-1 module will support & maximum of B asynchionous, concurnent connections. Select
how many connections you wish to configure for this madule.

MNumber of connections to configure for this module:

[ = o9

Click Next' to edit the connections for this configuration.

<Prev New> |  Cancel

A E) S7T-300 FIIRSS 23%E#E
AN PSS = A ST HE PRk A 55 #s i 82
it CP343-1 1) S7-300 w441k %% /v FH T M 55 A i 4.
7 NS R IR S5 45 (ST- 200)$DEF' 15(S7-300), 151 U1,S7 3% H XU

S7-200 1 S7-300 [1] S7 & # ik TSAP Sk . zefE TSAP ¥ E 4 10.04.
% TSAP 5 40k

o 10: SULAAER
e 04: S7-300 35+ CP &5

TE L0 S Ad FH A7 AR Rl LAOK R332 111 S7-300 [#) CPU,Zii%i A\ CPU (1 =

Wk “Accept all connection requests.” & ZEHE, £ “Next Connection” #4713t
— 1 ST A%

V1.1
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2-26 HA A3 S7-300 (1)) 5% 2t
3

‘fou have requested 4 connection(s]. For each connection, specily whethes the connection should act as a
chent or server, and configure its associated properties,

- Connection 2 (4 connections requested]

" This is a Client Connaction: Clisnt connections request data transfers between the local PLC and 3
remote server.

¥ This iz a Server Connection: Servers respond to connection requests from remote clients.

Local Properties [Server)]——————— [ Remote Properties [Client]
TSAP TSAP
I 12.00 I 10.04
[~ This server will connect with an Dpesator
Panel [OP).

[V Accept all connection remests.]

< Prev Connection ] Next Connection » |

oK | Cancel |

—ANE ST-400 WK S 288
AP DA ST FEHRKG A N i 55 ds i 4
it CP443-1 [1) S7-400 ulKeAE k% ;v T+ Mk 55 i ie 42
é%/}rizﬂuﬁﬂ&%%%(smooﬁng)‘ﬂﬁ (S7-400), 151 411,S7 % B2 1 XU

S7-200 F1 S7-400 [¥] S7 & #M i TSAP k5 .z e TSAP ¥ & 4y 10.03.
i% TSAP & X4k

e 10: mﬁlé.ﬁn_ﬂ%%
e 03:S7-400 3+ PLC ffE 5

ik “Accept all connection requests.” & JEAE, &t “OK % £ BEAT 2 F —ANXt
T AE 115

V1.1

15.08.2008 24/32



Copyright © Siemens AG 2008 All rights reserved

S7_Komm_S7300_cn.doc

SIEMENS

S7 communication between S7-200 and S7-300/400

K] 2-27 HA—ANF] ST7-400 )R 55 2842

Configure Connections = x|

You have requested 4 connectionfs). For each connection, specify whether the connection should act as a
client or zerver, and configure itz aszociated propesties.

— Connection 3 (4 connechions requested)
" Thig is a Client Connection: Clent connections request data transfers between the local PLC and a
remobe server.
& Thig is a Server Connection: Servers respond to connection requests from remate chents.

— Local Properties [Server) - Remote Properties [Client]
TS4P TS54P

| 13.00 | 1003

[~ This server will connect with an Operator
Panel (OF).

¥ Accept all connection requests.

Arcept connechon requests from the followimng

cliert oy
| 0.0.0.0

¥ Enﬂelh&up%hﬂcﬁmlm&ucwm]

nrection. T our programican reference this connection

< Prey Connection I ezt Conmection >

ok | cancal |

T CP243-1 #2725 m)
Alive Interval I i) {764 &E.ZEﬁﬁi,,Next“ﬁ?’éﬂ.

2-28 CRC #4714l Alive Intervall I [a] % &
Ethernet Wizard (ETH Configuration for D) i

- CRC Protection

4 H ID: 17369594

EANRENS 11 IS O, DR e % CRC R I

modifications to the configuration at mn time.

" No, do not generate CRC pratection for this configuration.

The wizard can generate a CRL to help protect the module configuration from unntentonal
memory overwites. Howeyer, this protection will alzo prevent your program from making

(% ‘Yes, generate CRC protection for this configuration in the data block.

~ Keep Alve Imerval

interval for the Keep Alve funclion, in seconds.

30_% o

|&
i
L]

Industrial

‘when connected with a remate communécations partrer, of when communicating with STEP
7-Micto/WIN, the CP 243-1 madule can ensure the connection on a timed interval. Specify the

Ix

I e

V1.1
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EFE A H 1 D A S B

2-29 {7k CP243-1 [(AA R E
Ethernet Wizard (ETH Configuration for D)

— Allocate Memaory for Configuration

The configuration block for this module requires 24 bytes of V-Memory, With the options you
hawe chosen, the total size of the configuration is 245 bytes. Please specily a starting addiess
whete the configuration vill be placed in the Data Block,

The wizard can suggest an address that represents an unused block of V-memory of the correct

size.
Suggest Address 1
| YB212  through VB456

frr}
Industrial B

<Prev Cancel

s, Finish* 8 58 B LUK R 1) 5 BEE.

V1.1 15.08.2008 26/32



Copyright © Siemens AG 2008 All rights reserved

S7_Komm_S7300_cn.doc

Sl E M EN S S7 communication between S7-200 and S7-300/400

4 H ID: 17369594

2-30 52 CP243-1 LUK M A& 5 &

_"_GEI The Ethemet \wizard will now generate the project companents for vour selected configuration

ol . and make that code available for use by your program. *f'our requested configuration consists of
b ol % @ the follovang project components:

The module configuration will be placed at (VB0 - VB201) n Data Page "ETHO_DATA"

Subroutine "ETHO_CTRL™

Subroutine "ETHD_XFR"

Global Symbol Table "ETHO_5YM"

4| | i3

Call the intialization and control subroutine “"ETHO_CTRL" every scan.

The CP 243-1 module configuration must be downloaded to the PLC before uze.

|5

Thiz wizard configuration vill be referencad in the project tres by name. “You can edit the default
name to better identify this wizard configuration.

ETH Configuiation for 0

v [ Finish | Cancel |

2 JEifEL ETHX_CTRL l ETHx_XFR ¥4k 1 . 0525 #E STEP 7-MicroWIN
() FARFRH(“MAIN (OB1)”)Hifi I ix He T g He.

Iified ETHx_CTRL JH T g a7 il

2-31 {4 ETHO_CTRL

[ PROGRAM COMMENTS
Metwork 1 Metword Title
[ Network Comment
SM0O.0 ETHO_CTRL

| 2

CP_Re™M10.0
Ch_Re~ M2
Errar b Mw/14

ER Hhfietk ETHX_XFR A %0 7 S b AT 2 A% 6 5 4 3 iR

TRAFAZSIF 82 S7-200 .

V1.1 15.08.2008 27/32
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2.4 S7-300/400 42 K% P imidE4TST R
S7T EEAS

Copyright © Siemens AG 2008 All rights reserved
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A R4 ] S7-300 15 AR ST S7 3%, 6T S7-400 AL IE —FEI.

7t STEP7 " 4] JF S7-300 It H 3¢ {1 i, Options> Configure Network“mi #
JEARXT R EIARFT IT NetPro X i AE.

2-32 #7 7T NetPro

QS]HAT]E Manager - [§7_300 -- C:\,Documents and Settings)...\\Desktop'Projec
Bp Fie Edt Insert PLC View | Options Window Help

D G”' g? @ n'% Eﬁ E‘ Customize. .. Chrl4+-Ak+E Filte
Access Protecti b
= 29 57.300 e 4
= [ SIMATIC 400 Change Log
[ SIMATIC 315-2DP Text Libraries »
[ (z S7-Programen Language for Display Devices...
Manage Multlingual Texts 3
HiE=1 Pra =
mipare Blocks
Reference Data k
Define Globs Data

7F NetPro ik S7-300 /) CPU Jfii i 2 ¥y 4, Insert > New
Connection ¥ il1—/NHTiE £,

2-33

"'ﬁ-NetPro - [57_300 {Network) -- C:\Documents and Settings",...\S7_300]
B yetwork  Edit | Insert PLC View Options Window Help

|8 By G Newokobeds  cihs H@m 1| a2

W vewConnection...  Ctl+N ]
Eind: I_ .|| DP [Maste

. PROEINET I
Selection of the nety

T _I1 =TT
= ™ rRorBUsop | _HOFIBUS
PROFIBUS-PA T

= B¢ PROFINET 10
-] Stations
g SIMATIC 400
Subnet -
= Subnets H |CPU DP H’UDF CP CP
W 4182 4431 [4a435
= |op I H T Ext
m E m ||
2 2 2
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HL 22 )5 ST N X THER T T

2-34 HHNHERE

~ Connection Paitner

= (8] Inthe current project
=] % TEST
B SIMATIC 300_PN
CPU 3152 DP
O [Unspecm]
e Al broadeast stations
------ - All multicast stations
@ In unknown project

£

Praject: ]

Station: ][lepociﬁed]

W odule; I

— Connection

P’ Displey properties before nserting

Type: ]S? connhection =]

ok | Aoy | Concel |

Help

V1.1
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T S7 &R 1 S7-300 6 a, K AE S7 JEFE 1 & M X Ui AE Fp 2500
,Establish an active connection“ & EHE. fiy Nl {5 1k CP243-1 (1] IP Mk,

2 J5& B ii“Address Details 4441

2-35 S7 FEH B X UG HE

Properties - ST connection -

General | Status Information |

i Local Connection End Paoint Block Parameters
I Fived configured dynamic conrection ‘ Local 1D [Hext WH1EH1
F Oneway |T
IF Establish an active connection l
T Send operating mode messages Default
- Connection Path
Local Partrier
P SIMATIC 315-2DP/ Unikrown
EndPort — |ceu 31520P
Intetface: CP 3431(R0/54) =] Junknown =
Subnet: [Ethemet[1) [Industiial Ethemet] |Industrial Ethernet]
Address: [4080.050 2050060 1
Address Details... |

oK |

Cancel |  Hep |

7 ,Address Details" X iFAHE 14 Nl A5 Ak F1 1) TSAP 141 S7-200 FA

TSAP (#5144 12.0).
2-36 Address Details i HE

Local Partner

S SIMATIC 315-2DP/ Unknown
End Paint: P 3431 |
Rack/Slok jo [+ o [0
Connection Resource p— 12 -
(hext 10
TSAP: 10.04 12.00
57 Subnet ID: |012C - 0006

| oK '

V1.1 15.08.2008
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7£ NetPro F1i&H S7-300 uhi . frA7 K 4w o 43 S7-300 H.

£ ST R /7 i I DhREsk

5 E{E S7-300 FE/7Hh I H Uhfig b FB14 “GET” F1 FB15 “PUT”. 1 LL{E
Standard Library & Communication Blocks = Blocks F$£3ix 461 fg He.

Kl 2-37 ¥/ FB14 “GET” I FB15 “PUT”

FEBlOO : Ticle:

Comment

W Ticle:

Comment :

CALL "GET" , DEl4

DONE :=MZ0.0

ERROR :=MZO0.1

STATUS: =MWZZ
ADDR_1:=P#DELl.DBX 40.0 BYTE 8
5 1 :=PEDBZ0D.DEX40.0 BYTE 8

g
2 REQ  :=MO.5
8 Ir (=WELEHE
£ NDR  :=M10.0
58
23 ERROR :=Ml10.1
<5 STATUS: =MWL2
o
s ADDE_1:=P#DBELl.DBX 30.0 BYTE 2
05 ID 1 :=PgDB20.DEX30.0 BYTE 8
o E
S E
g‘x" CALL "“PUT" , DELES
gg) REQ  :=M0.5
= I c=ELEEE
2
s
3
[&]

T s A T T REFB14 “GET” Al FB15 “PUT KM A\ S48, ID* AT LA H
SAEANAHIDZE R AL ] DL S7 L m Mk B A KIE R ID (2 W | 2-35

S7 HEH EPERTURAE).
IhREH: FB14 “GET” Al FB15 “PUT % A %L, ADDR_1 “ }j S7-200 % H
A 13 X k.

I (13 5 X853 A AR S7-200 1 V X,V X 5 S7-300 (1) DB HudikAHXS AV

EE Al ] S7-400 D625 F BhfieHe SFB14 “GET” #1 SFB15 “PUT”. aJ AE
Standard Library > System Function Blocks = Blocks #&#I[iX £E1f g k.
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S7-300 T iEHhEEtk FB14 “GET” Ml FB15 “PUT” (6] 725
n] Ll ik PLRID5 $: 3] S7-300 H i DhREERFB14 “GET” A1 FB15 “PUT"[)
%7 F2)7: 18610307.

S7-400 HiE T Eetk SFB14 “GET” f1 SFB15 “PUT [\ F12/%

LA LR ID 5 $2.21S7-400 i ] T AEHSFB14 “GET” #1 SFB15 “PUT”
451 F2 e 1819293.

3 RRCAS B8 3 3 52

fRA EE:t] g3
V1.0 22.04.2008 | kR
V1.1 15.08.2008 | 5E# &K
V1.2 19.04.2013 | 2.1 &R “HER”
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